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What RBC Pages Should Be Submitted?

For year-end 2017 life RBC, submit hardcopies of pages
LRO001 through LR049 to any state that requests a hard-
copy in addition to the electronic filing. Starting with
year-end 2007 RBC, a hardcopy was not required to be
submitted to the NAIC. However, a portable document
format (PDF) file representing the hardcopy filing is part
of the electronic filing.

If any actuarial certifications are required per the RBC
instructions, those should be included as part of the hard-
copy filing. Starting with year-end 2008 RBC, the actuar-
ial certifications were also part of the electronic RBC
filing as PDF files, similar to the financial annual state-
ment actuarial opinion.

Other pages, such as the mortgage and real estate Wo&
sheets, do not need to be submitted, but they still ne
retained by the company as documentation.

Risk-Based Capital Level of Action

As a result of the adoption of agend -01-L-
RBC Ratio by the Capital Ade avk Force at
the Spring National Meeting, a li as a®icd to LR0O34

Risk-Based Capital Level of Action t0%ow the Author-
ized Control Level RBC % consistent with the

other RBC formulas and to ji ity data pulls.

In This Is
What RBC Pages DMt . 1
Risk-Based Capital Level of Action..........c.cccovieennnn. 1
XXXIAXXX Reins. Primary Sec. Shortfall .................. 1
Operational RISK...........cccoiiiiiiiiiiceise e 1
Money Market Mutual Funds..........ccccooeeveiieinenenns 2
Unaffiliated Common Stock Money Market Mutual
FUNAS. ..o 2
Supp. Ben. w/Stand-Alone Med. Pt. D Coverage ......... 2
0] oI 0 SRS 2

Contact INformation ...........ccceeveiveeiieiecie e 2

XXX/AXXX Reinsurance Primary Security
Shortfall by Cession

As a result of the adoption of da item 2017-02-L
Primary Security Shortfall ticy Change by the
Capital Adequacy (E) §ask @ its June 28 confer-

ence call, changes were e Wpthg¥instructions to clarify
jec Actuarial Guideline
in Memorandum Require-

only list cessions
XLVIl—Actuarial
olicies Required to be Val-
of the NAIC Valuation of Life
del Regulation (AG 48). For
some policies subject to AG 48 and
ct to the Term and Universal Life

treatie§th

some polgie

Insurg@Ce rve Financing Model Regulation (#787),
(&orti n of the cession regulated by AG 48 is to
b u

\%ational Risk

As a result of a technical issue that was presented during
the June 28 Capital Adequacy (E) Task Force conference
call, implementation of a risk factor for Operational Risk
has been deferred for at least a year. The Task Force
adopted agenda item 2016-13-O at the Spring National
Meeting and modified it on its June 28 conference call.
At the Spring National Meeting, the Task Force in
essence voted to “go live” for 2017 reporting by adopting
the structural change to remove the proxy-based
approach, move the “add-on” approach for basic opera-
tional risk to page LRO31 and retain the growth risk
portion of the information only page. On its June 28
conference call, the Task Force adopted the operational
risk instructions but voted to reduce the recommended
RBC charge from 1.5% to 0% for 2017 to allow the
Operational Risk (E) Subgroup to address the technical
concerns raised.
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Money Market Mutual Funds

As a result of the reclassification of money market
mutual funds (MMMFs) to cash equivalents by the
Statutory Accounting Principles (E) Working Group,
the Capital Adequacy (E) Task Force adopted agenda
item 2016-15-CA at the Spring National Meeting.
MMMFs will be isolated on their own line on the
Miscellaneous Assets schedule and subtracted from the
cash equivalents. The Annual Statement Source will be
Schedule E, Part 2, Column 7, Line 8599999.

Page 2

Stop Loss

As a result of the adoption of agenda item 2016-17-CA
by the Capital Adequacy (E) Task Force at the Spring
National Meeting, a tiered factor approach will be
applied to Stop Loss premiums. A fo
apply a factor of 0.350 to the first

loss premium and a factor of 0 premium in
L 4

was added to
5 ion in stop

excess of $25 million.

N

Unaffiliated Common Stock MMMFs Supplemental ne within Stand-Alone

Medicare P age
As a result of the adoption of agenda item 2017-06-CA, ¢
by the Capital Adequacy (E) Task Force onthe June 28  As a res N option of agenda item 2016-16-CA
conference call, the factor was modified to 0% on Line by tal Atequacy (E) Task Force at the Spring

ing, the factor for Supplemental Benefits
-Alone Medicare Part D Coverage was
to 0.500 and will be applied to claims incurred.

(22) on LROO5 Unaffiliated Preferred and Common  Nati
Stock. The purpose of the modification is to avoid the isinin
double counting of MMMFs in both cash equivalen% C
and common stock. The instructions were also revise

to reflect the change.

NS

9
o

on of Insurance Commissioners

Direct correspondence to: Dave Fleming, RBC Newslet-
ters, NAIC, 1100 Walnut Street, Suite 1500, Kansas City,
MO 64106-2197. Phone: (816) 783-8121. Email: dflem-
ing@naic.org.

Address corrections requested. Please mail the old
address label with the correction to: NAIC Publications
Department, 1100 Walnut Street, Suite 1500, Kansas
City, MO 64106-2197. Phone: (816) 783-8300. Email:
prodserv@naic.org.

Life Risk-Based Capital Newsletter Volume 23. Published
annually or whenever needed by the NAIC for insurance
regulators, professionals and consumers.
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The Life RBC Forecasting CD-ROM contains a spreadsheet that calculates RBC using the

presented in the 2017 NAIC Life Risk-Based Capital Report Including Overview &
Companies. A hardcopy of this booklet is mailed with the forecasting CD-ROM or vailable for

download from the NAIC Publications Department. Q

L 4
The forecasting spreadsheets can be used to check RBC results throughout t 0 early look at
RBC results before the RBC vendor filing software may be available, or to evggate at-if” scenarios.

WARNIN 0‘_

The RBC Forecasting Spreadsheet CANNO? e to meet the year-end
RBC electronic filing requirement. RBC ware from an annual
statement software vendor should be us eate the electronic filing. If
the forecasting worksheet is sent inste ectronic filing, it will not be

t

accepted, and the RBC will not haye d.
User Requirements About the File
« A Microsoft Windows® version ofg¥icrosoft )

Excel 2010 (or compatible versiggs): The spreadsheet Forecast_Life 2017 _08_
« Five megabytes of hard gisk s 18.xIsm was created in Microsoft Excel. The
« A good understandi % adsheet spreadsheet can be used with Microsoft Excel

version 14.0 or higher. The spreadsheet
includes menus for use in navigation between

software.

Installation from th@&D-ROM pages and for printing.

To install the sp ot Tiles, start Windows The RBC spreadsheet above follows the 2017

Explorer a % D-ROM drive where Life Risk-Based Capital Report Including

the forecastingWgrea®neet is located. Overview and Instructions for Companies
formula pages. A copy of the instructions and

Copy ary, Paste the Forecast Life 2017 blank are included with the CD-ROM to assist

08_18.xIsm™§le in the directory where you in the completion of the forecasting file.

would like the file to be saved.
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Usage

1. Open the Forecast_Life 2017 _08_18.xlsm file by double clicking on the file.

2. Enter data as described in the following sections and examine the results.

3. Save any changes to the spreadsheets using the “Save” command from the “File” menu.

Please Note

In certain versions of Excel, the user may receive the following message when the ing file is
opened:

\!; Security Warning  Some active content has been disabled. Click for more details,

If this is the case, the user would need to click on the “Enable Content” hutton

To change the Excel security level, go to the Developer tab, in , click Macro Security. In
the Macro Settings, select the security option. ¢
Macro Settings \

- P Record Macro Disable all macros WgRout M¥tification
' @ Disable #fmac

He LUse Relative References ith Motification

"g'i'-m Macra & a ept digitally signed macros
asic

le cros (not recommended; potentially dangerous code can run)
Data Entry

The RBC spreadsheets have begi{ color-coded for easy use.

ts that tie directly to the 2017 life annual statement (i.e.,
be found in the company's annual statement filing.
ents that are not available directly from the annual statement (e.g.,
. These items come from other company records as noted in the

Ils are data elements that must be entered using a separate input worksheet.
= cell will automatically take the user to the input worksheet when using the
ife_ 2017_08 18.xIsm file. Data input into the separate worksheet will feed
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What-If Scenarios

One of the unique features of the forecasting spreadsheet is its ability to perform what-if calculations.
Because the formula is implemented through the Excel spreadsheet, the user is able to run various
scenarios by adjusting the book/adjusted carrying value, amount or statement value to analyze the effect
such changes would have on the company’s overall RBC ratio based on the RBC factors and covariance.

Saving and Exiting

To exit the program, simply click the “ in the upper right corner of the file or ch e "EXit” from

the “File” menu. The spreadsheet program will prompt to save any files that ha®e bed Jed.

» Answer “yes” at the prompt to save any changes, such as data input or forn& S.
Il

» Answer “no” if the saving is not desired. Warning: This will ignore any a r changes.
Printing

A print menu was added to aid in printing for Excel users. (,ﬁ D0oX next to the page name for
e

the individual pages that are desired to be printed. Then se getton for “Print Selected Pages.”
Select the “Reset” button any time it is desired to haveall ons G¥selected. Individual boxes can also
be deselected by clicking on them. K

RBC Forecasting Tips .

Ng of the Excel file is available. The NAIC will
adu shipping or is otherwise defective.

2. Gather information required for the affilialgd ipfestments section before beginning. In some instances,
information will need to be gathered from thé®various affiliates themselves.

1. Make sure the CD-ROM is retained so 2
not replace the CD-ROM unless it wa

3. Keep a copy of the NAIC ann ent blank and annual statement instructions nearby and refer to
them as needed.

4. Keep the copy of the R w and Instructions at the computer to be used as a reference while
filling out the spreadsheet. preadsheet follows the RBC Overview and Instructions formula pages
exactly.

5. Make a list of ns hile filling out the spreadsheet. Then call the NAIC staff once, saving both
parties :

icemail messages, make the question as specific and detailed as possible. We will
then le to call back with the answer, saving time spent on the phone. Please leave a phone number
or email cglress, and we will get back to you with an answer as soon as possible.
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Questions and Support

If problems are encountered, please refer to the RBC Overview and Instructions booklet and/or the
Forecasting Spreadsheet Instructions first. However, if there is still a question, contact the NAIC.

For questions pertaining to annual statement references, insurance accounting questions or formula
questions, contact Dave Fleming (NAIC).

For computer-usage related questions (loading the product, etc.), contact the NAIC Help Q
Important Contact Information & O

e Formula questions: Dave Fleming, (816) 783-8121; dfleming@naic.org. \

» Computer questions: NAIC Help Desk, (816) 783-8500; help@naic.o

» Annual statement questions: NAIC Financial Reporting Quessi

g
» Questions on publications: NAIC Publications, (816) 783-8{&
L 2 \0. ,

L (816) 783-8400.

@naic.org.

9

o
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NAIC

National Association of Insurance Commissioners

The National Association of Insurance Commissioners
(NAIC) is the U.S. standard-setting and regulatory support
organization created and governed by the chief insurance
regulators from the 50 states, the District of Columbia and five
U.S. territories. Through the NAIC, state insurance regulators
establish standards and best practices, conduct peer review,
and coordinate their regulatory oversight. NAIC staff supports
these efforts and represents the collective views of state
regulators domestically and internationally. NAIC members,
together with the central resources of the NAIC, form the
national system of state-based insurance regulation in the U.S.

For more information, visit www.naic.org.
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